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1 Printer overview

● Warning icons

● Printer views

● Printer specifications

● Printer hardware setup and software installation

For more information:

In the US, go to www.hp.com/support/ljM14.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Warning icons
Warning icon definitions: The following warning icons may appear on HP products. Apply appropriate caution 
where applicable.

●
Caution: Electric shock

●
Caution: Hot surface

●
Caution: Keep body parts away from moving parts

●
Caution: Sharp edge in close proximity
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Printer views
● Printer front view

● Printer back view

● Control panel view

Printer front view

1 2

3
1 Control panel

2 Output bin

3 Input tray and front door access

Printer back view

2

1

1 USB interface port

2 Power connection
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Control panel view

Base models

1

2

3

1 Attention LED The Attention light blinks when the printer requires user attention. If the Attention light is 
on, the printer is in an error state.

2 Power button/Ready LED Use this button to turn the printer on or off.

The Ready light is on when the printer is ready to print. It blinks when the printer is 
receiving print data and dims when the printer is in a low-power state.

3 Resume/Cancel  button Press this button for the following actions:

● If the printer is currently processing a job, with Attention LED off and Ready LED 
blinking, press the button to cancel the print job.

● If the printer is in a error or prompt state, with Ready LED On and Attention LED 
blinking, press the button to clear the error and resume printing.

● In manual duplex mode, press this button to print the second side of the page.

Wireless models

1

2

3

4

1 Wireless  button and LED 

(wireless models only)

Press this button to turn the wireless feature on or off, or to configure a WiFi Direct 
connection.

Press and hold this button to configure a WPS connection.

If the wireless LED light is on, there is a stable wireless connection. If it is blinking, there is 
currently no wireless connection, or there is either a WPS or WiFi Direct configuration 
process in progress. If it is blinking rapidly, there is an issue with the wireless connection.
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2 Attention LED The Attention light blinks when the printer requires user attention. If the Attention light is 
on, the printer is in an error state.

3 Power button/Ready LED Use this button to turn the printer on or off.

The Ready light is on when the printer is ready to print. It blinks when the printer is 
receiving print data and dims when the printer is in a low-power state.

4 Resume/Cancel  button Press this button for the following actions:

● If the printer is currently processing a job, with Attention LED off and Ready LED 
blinking, press the button to cancel the print job.

● If the printer is in a error or prompt state, with Ready LED On and Attention LED 
blinking, press the button to clear the error and resume printing.

● In manual duplex mode, press this button to print the second side of the page.

ENWW Printer views 5



Printer specifications
IMPORTANT: The following specifications are correct at the time of publication, but they are subject to change. 
For current information, see www.hp.com/support/ljM14.

● Technical specifications

● Supported operating systems

● Mobile printing solutions

● Printer dimensions

● Power consumption, electrical specifications, and acoustic emissions

● Operating-environment range

Technical specifications
See www.hp.com/support/ljM14 for current information.

Supported operating systems
The following information applies to the printer-specific Windows PCLmS and OS X print drivers.

Windows: The HP Software Installer installs the PCLmS, or PCLm-S driver depending on the Windows operating 
system, along with optional software when using the software installer. See the software installation notes for 
more information.

OS X: Mac computers are supported with this printer. Download HP Easy Start either from 123.hp.com/LaserJet 
or from the Printer Support page, and then use HP Easy Start to install the HP print driver. HP Easy Start is not 
included in the HP Software Installer.

1. Go to 123.hp.com/LaserJet.

2. Follow the steps provided to download the printer software.

Linux: For information and print drivers for Linux, go to www.hp.com/go/linuxprinting.

Table 1-1  Supported operating systems and print drivers

Windows 7, 32-bit and 64-bit The HP PCLmS printer-specific print driver is 
installed for this operating system as part of 
the software installation.

 

Windows 8, 32-bit and 64-bit The HP PCLmS printer-specific print driver is 
installed for this operating system as part of 
the software installation.

Windows 8 RT support is provided through 
Microsoft IN OS Version 4, 32- bit driver.

Windows 8.1, 32-bit and 64-bit The HP PCLm-S V4 printer-specific print 
driver is installed for this operating system 
as part of the software installation.

Windows 8.1 RT support is provided through 
Microsoft IN OS Version 4, 32- bit driver.

Windows 10, 32-bit and 64-bit The HP PCLm-S V4 printer-specific print 
driver is installed for this operating system 
as part of the software installation.
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Table 1-1  Supported operating systems and print drivers (continued)

Windows Server 2008 R2, 64-bit The HP PCLm.S printer-specific print driver is 
available for download from the printer-
support website. Download the driver, and 
then use the Microsoft Add Printer tool to 
install it.

Microsoft retired mainstream support for 
Windows Server 2008 in January 2015. HP 
will continue to provide best effort support 
for the discontinued Server 2008 operating 
system.

Windows Server 2008 R2, SP1, 64-bit The HP PCLmS printer-specific print driver is 
installed for this operating system as part of 
the software installation.

 

Windows Server 2012 The HP PCLmS printer-specific print driver is 
installed for this operating system as part of 
the software installation.

 

Windows Server 2012 R2 The HP PCLm-S printer-specific print driver 
is installed for this operating system as part 
of the software installation.

 

Windows Server 2016, 64-bit The HP PCLm-S printer-specific print driver 
is installed for this operating system as part 
of the software installation.

 

OS X 10.11 El Capitan, OS X 10.12 Sierra, 
OS X 10.13

To install the print driver, download HP Easy 
Start from 123.hp.com/LaserJet. Follow the 
steps provided to install the printer software 
and print driver.

 

NOTE: For a current list of supported operating systems, go to www.hp.com/support/ljM14 for HP's all-
inclusive help for the printer.

Mobile printing solutions
HP offers multiple mobile solutions to enable easy printing to an HP printer from a laptop, tablet, smartphone, or 
other mobile device. To see the full list and to determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting.

NOTE: Update the printer firmware to ensure all mobile printing are supported.

● Wi-Fi Direct (wireless models only)

● HP All-in-One Remote app for iOS and Android devices

● Google Cloud Print

● AirPrint (wireless models only)

● Android Printing
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Printer dimensions
Figure 1-1  Dimensions for the printer

1

2 3

1

2 3

Printer fully closed Printer fully open

1. Height 159 mm (6.3 in) 280.1 mm (11.1 in)

2. Width 346 mm (13.6 in) 346 mm (13.6 in)

3. Depth 189 mm (7.4 in) 329.6 mm (13 in)

Weight (with cartridges) 3.7 kg (8.2 lb)

Power consumption, electrical specifications, and acoustic emissions
See www.hp.com/support/ljM14 for current information.

CAUTION: Power requirements are based on the country/region where the printer is sold. Do not convert 
operating voltages. This will damage the printer and void the printer warranty.

Operating-environment range

Environment Recommended Allowed

Temperature 15° to 27°C (59° to 80.6°F) 15° to 30°C (59° to 86°F)

Relative humidity 20% to 70% relative humidity (RH), non-
condensing

10% to 80% (RH), non-condensing
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Printer hardware setup and software installation
For basic setup instructions, see the Setup Poster and Getting Started Guide that came with the printer. For 
additional instructions, go to HP support on the Web.

Go to www.hp.com/support/ljM14 for HP's all-inclusive help for the printer. Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Introduction

● Load paper trays

● Load and print envelopes

● Load and print labels

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljM14.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Introduction
CAUTION: Keep hands out of paper trays when closing.

All trays must be closed when moving the printer.

Load paper trays
The following information describes how to load paper into the input tray.

NOTE: To avoid paper jams:

● Never add or remove paper from the tray during printing.

● Before loading the tray, remove all of the paper from the input tray and straighten the stack.

● When loading the tray, do not fan the paper.

● Use paper that is not wrinkled, folded, or damaged.

Input tray
Load media with the top forward and the side to be printed on facing up. To prevent jams and skewing, always 
adjust the side guides.

NOTE: When you add new media, make sure that you remove all of the media from the input tray and 
straighten the entire stack. This helps prevent multiple sheets of media from feeding through the product at one 
time, reducing media jams.

12 Chapter 2   Paper trays ENWW



Load and print envelopes

Introduction
The following information describes how to print and load envelopes. Tray 1 holds up to 5 envelopes.

To print envelopes using the manual feed option, follow these steps to select the correct settings in the print 
driver, and then load the envelopes into the tray after sending the print job to the printer.

Print envelopes
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: In Windows 10, 8.1, and 8, these applications will have a different layout with different features 
than what is described below for desktop applications. To access the print feature from a Start screen app, 
complete the following steps:

● Windows 10: Select Print, and then select the printer.

● Windows 8 or 8.1: Select Devices, select Print, and then select the printer.

3. Click or tap the Paper/Quality tab.

4. In the Media drop-down list, select Envelope.

5. Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Envelope orientation

Tray Envelope size How to load envelopes

Tray 1 Envelope #10, Envelope C5, 
Envelope DL

Face up

Short, postage end toward the back of the tray
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Load and print labels

Introduction
The following information describes how to print and load labels. Tray 1 holds up to 50 sheets of labels.

To print labels using the manual feed option, follow these steps to select the correct settings in the print driver, 
and then load the labels into the tray after sending the print job to the printer. When using manual feed, the 
printer waits to print the job until it detects that the tray has been opened.

Manually feed labels
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: In Windows 10, 8.1, and 8, these applications will have a different layout with different features 
than what is described below for desktop applications. To access the print feature from a Start screen app, 
complete the following steps:

● Windows 10: Select Print, and then select the printer.

● Windows 8 or 8.1: Select Devices, select Print, and then select the printer.

3. Click the Paper/Quality tab.

4. In the Media drop-down list, select Labels.

5. Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Label orientation

Tray How to load labels

Tray 1 Face-up

Top edge toward the back of the tray
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3 Supplies, accessories, and parts

● Order supplies, accessories, and parts

● Replace the toner cartridge

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljM14.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Order supplies, accessories, and parts

Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on the computer, enter the 
printer IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.

Supplies and accessories

Item Description Cartridge number Part number

Supplies

For use only in Europe, Russia, CIS, Mid East and Africa

HP 44A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

44A CF244A

For use only in North America, Latin America, Asia Pacific Countries/Regions (Exclude China, India)

HP 48A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

48A CF248A

For use only in China, India

HP 47A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

47A CF247A
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Replace the toner cartridge

Cartridge information
Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. 
To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth 
about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner 
cartridge into the printer and close the cover.

Item Description Cartridge number Part number

Supplies

For use only in Europe, Russia, CIS, Mid East and Africa

HP 44A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

44A CF244A

For use only in North America, Latin America, Asia Pacific Countries/Regions (Exclude China, India)

HP 48A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

48A CF248A

For use only in China, India

HP 47A Black Toner Cartridge Standard-capacity replacement black toner 
cartridge

47A CF247A

Remove and replace the toner cartridge
When a print cartridge approaches the end of useful life, you can continue printing with the current cartridge 
until redistributing the toner no longer yields acceptable print quality.

1. Open the print-cartridge door, and then remove the old print cartridge.
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2. Remove the new print cartridge from the packaging. Place the used print cartridge in the bag and box for 
recycling.

CAUTION: To prevent damage to the print cartridge, hold the print cartridge at each end. Do not touch the 
OPC cover or roller surface.

3. Grasp both sides of the print cartridge and gently rock the print cartridge to distribute the toner evenly 
inside the cartridge.

4. Bend the tab on the left side of the cartridge until the tab breaks loose, and then pull the tab until all the 
tape is removed from the cartridge. Place the tab and tape in the print-cartridge box to return for recycling.
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5. Remove the orange cover from the print cartridge.

6. Insert the print cartridge in the product, and then close the print-cartridge door.

CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold water. 
Hot water sets toner into the fabric.
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4 Print

● Print tasks (Windows)

● Print tasks (OS X)

● Mobile printing (wireless models only)

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljM14.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information

NOTE: When the Attention and Ready lights are blinking, the printer is initializing, cleaning, or cooling down. 
When the printer is cooling down print jobs might pause. Print jobs will continue when the engine is ready. This 
might take several minutes. 

To provide productive printing, this HP LaserJet Pro may automatically enter cool down mode under certain 
environmental conditions when required.
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Print tasks (Windows)

How to print (Windows)
The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the printer from the list of printers. To change settings, click or tap the Properties or Preferences 
button to open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: In Windows 10, 8.1, and 8, these applications will have a different layout with different features 
from what is described below for desktop applications. To access the print feature from a Start screen app, 
complete the following steps:

● Windows 10: Select Print, and then select the printer.

● Windows 8.1 or 8: Select Devices, select Print, and then select the printer.

3. Click or tap the tabs in the print driver to configure the available options.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from this 
screen.

5. Click or tap the OK button to print the job.
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Manually print on both sides (Windows)
Use this procedure for printers that do not have an automatic duplexer installed or to print on paper that the 
duplexer does not support.

1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: In Windows 10, 8.1, and 8, these applications will have a different layout with different features 
from what is described below for desktop applications. To access the print feature from a Start screen app, 
complete the following steps:

● Windows 10: Select Print, and then select the printer.

● Windows 8.1 or 8: Select Devices, select Print, and then select the printer.

3. Click the Layout tab.

4. Select the appropriate duplex option from the Print on Both Sides Manually drop-down list, and then click 
the OK button.

5. In the Print dialog box, click the OK button to print the job. The printer will print the first side of all the pages 
in the document first.

6. Retrieve the printed stack from the output bin, and place it with the printed-side facing down, top edge first 
in the input tray.

123

7. At the computer, click the OK button to print the second side of the job.

8. If prompted, select the appropriate control panel button to continue.

Print multiple pages per sheet (Windows)
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.
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NOTE: In Windows 10, 8.1, and 8, these applications will have a different layout with different features 
from what is described below for desktop applications. To access the print feature from a Start screen app, 
complete the following steps:

● Windows 10: Select Print, and then select the printer.

● Windows 8.1 or 8: Select Devices, select Print, and then select the printer.

3. Click or tap the Layout tab.

4. Select the correct Orientation option from the drop-down list.

5. Select the correct number of pages per sheet from the Pages per sheet drop-down list, and then click or 
tap the Advanced button.

6. Select the correct Pages per Sheet Layout option from the drop-down list.

7. Select the correct Page Borders option from the drop-down list, click or tap the OK button to close the 
Advanced Options dialog box, and then click or tap the OK button to close the Properties or Preferences 
dialog box.

8. In the Print dialog box, click the OK button to print the job.

Select the paper type (Windows)
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE:

● Windows 10: Select Print, and then select the printer.

● Windows 8.1 or 8: Select Devices, select Print, and then select the printer.

3. Click or tap the Printing Shortcuts tab.

4. From the Paper Type drop-down list, select the correct paper type, and then click or tap the OK button to 
close the Properties or Preferences dialog box.

5. In the Print dialog box, click the OK button to print the job.
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Print tasks (OS X)

How to print (OS X)
The following procedure describes the basic printing process for OS X.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then select other menus to adjust the print settings.

NOTE: The name of the item varies for different software programs.

4. Click the Print button.

Manually print on both sides (OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Manual Duplex menu.

NOTE: The name of the item varies for different software programs.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the printer, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (OS X)
1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Layout menu.

NOTE: The name of the item varies for different software programs.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.
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Select the paper type (OS X)
1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Media & Quality menu or the Paper/Quality menu.

NOTE: The name of the item varies for different software programs.

4. Select from the Media & Quality or Paper/Quality options.

NOTE: This list contains the master set of options available. Some options are not available on all printers.

● Media Type: Select the option for the type of paper for the print job.

● Print Quality: Select the resolution level for the print job.

5. Click the Print button.
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Mobile printing (wireless models only)

Introduction
HP offers multiple mobile solutions to enable easy printing to an HP printer from a laptop, tablet, smartphone, or 
other mobile device. To see the full list and to determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting.

NOTE: Update the printer firmware to ensure all mobile printing capabilities are supported.

Wi-Fi Direct
Wi-Fi Direct enables printing from a wireless mobile device without requiring a connection to a network or the 
Internet.

Wi-Fi Direct does not support all mobile operating systems. If the mobile device does not support Wi-Fi Direct, 
you must change the wireless network connection of the device to the Wi-Fi Direct connection of the printer 
before printing.

NOTE: For non-Wi-Fi Direct capable mobile devices, the Wi-Fi Direct connection only enables printing. After 
using Wi-Fi Direct to print, you must reconnect to a local network in order to access the Internet.

To access the printer Wi-Fi Direct connection, complete the following steps:

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.

3. On the Networking tab, click the Wi-Fi Direct Setup link in the left navigation pane.

4. Choose one of the following connection methods:

● Manual

● Automatic

5. On the mobile device, open the Wi-Fi or the Wi-Fi Direct menu.

6. From the list of available networks, select the printer name.

NOTE: If the printer name does not display, you might be out of range of the Wi-Fi Direct signal. Move the 
device closer to the printer.

7. If prompted, enter the Wi-Fi Direct password.
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NOTE: For Android devices that support Wi-Fi Direct, if the connection method is set to Automatic, the 
connection will occur automatically, without a password prompt. If the connection method is set to Manual, 
you will need to either press the Wireless button on the printer to connect to an Android device, or provide a 
personal identification number (PIN) — available on a printed report— to connect to Windows (8.1 or later) 
devices.

NOTE: To access the Wi-Fi Direct password, from the EWS open the Networking tab, and then click Wi-Fi 
Direct Setup.

8. Open the document, and then select the Print option.

NOTE: If the mobile device does not support printing, install the HP ePrint mobile app.

9. Select the printer from the list of available printers, and then select Print.

10. After the print job is complete, some mobile devices need to be reconnected to the local network.

The following devices and computer operating systems support Wi-Fi Direct:

● Android 4.0 and later tablets and phones with the HP Print Service or Mopria mobile printing plugin installed

● Most Windows 8.1 computers, tablets, and laptops that have the HP print driver installed

The following devices and computer operating systems do not support Wi-Fi Direct, but can print to a printer that 
does:

● Apple iPhone and iPad

● Mac computers running OS X

For more information on Wi-Fi Direct printing, go to www.hp.com/go/wirelessprinting.

Wi-Fi Direct capabilities can be enabled or disabled from the HP Embedded Web Server (EWS).

Enable or disable Wi-Fi Direct

Wi-Fi Direct capabilities must be enabled first from the printer EWS.

Step one: Open the HP Embedded Web Server

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.
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Step two: Enable or disable Wi-Fi Direct

1. On the Networking tab, click the Wi-Fi Direct Setup link in the left navigation pane.

2. Select the On option, and then click Apply. Selecting the Off option disables Wi-Fi Direct printing.

NOTE: In environments where more than one model of the same printer is installed, it might be helpful to 
provide each printer a unique Wi-Fi Direct name for easier printer identification for Wi-Fi Direct printing.

Change the printer Wi-Fi Direct name

Follow this procedure to change the printer Wi-Fi Direct name using the HP Embedded Web Server (EWS):

Step one: Open the HP Embedded Web Server

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.

Step two: Change the Wi-Fi Direct name

1. On the Networking tab, click the Wi-Fi Direct Setup link in the left navigation pane.

2. In the Wi-Fi Direct Name field, enter the new name.

3. Click Apply.

AirPrint
Direct printing using Apple’s AirPrint is supported for iOS and from Mac computers running OS X 10.7 Lion and 
newer. Use AirPrint to print directly to the printer from an iPad, iPhone (3GS or later), or iPod touch (third 
generation or later) in the following mobile applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the printer must be connected to the same network (sub-net) as the Apple device. For more 
information about using AirPrint and about which HP printers are compatible with AirPrint, go to 
www.hp.com/go/LaserJetMobilePrinting.
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NOTE: Before using AirPrint with a USB connection, verify the version number. AirPrint versions 1.3 and earlier 
do not support USB connections.

Android embedded printing
HP's built-in print solution for Android and Kindle enables mobile devices to automatically find and print to HP 
printers that are either on a network or within wireless range for Wi-Fi Direct printing.

The print solution is built into the many versions of the operating system.

NOTE: If printing is not available on your device, go to the Google Play > Android apps and install the HP Print 
Service Plugin.

For more information on how to use Android embedded printing and which Android devices are supported, go to 
www.hp.com/go/LaserJetMobilePrinting.
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5 Manage the printer

● Change the printer connection type (Windows)

● Advanced configuration with HP Embedded Web Server (EWS) and HP Device Toolbox (Windows)

● Advanced configuration with HP Utility for OS X

● Configure IP network settings

● Printer security features

● Energy-conservation settings

● Update the firmware

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljM14.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Change the printer connection type (Windows)
If you are already using the printer and you wish to change the way it is connected, use Device Setup & Software 
to change the connection. For example, connect the new printer to the computer using a USB, or change the 
connection from a USB to a wireless connection.

To open Device Setup & Software, complete the following procedure:

1. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder for 
the printer, and then select the printer name.

2. In the HP Printer Assistant, select Tools from the navigation bar, and then select Device Setup & Software.
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Advanced configuration with HP Embedded Web Server (EWS) and 
HP Device Toolbox (Windows)

Use the HP Embedded Web Server to manage printing functions from your computer.

● View printer status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● Receive notification of printer and supplies events

● View and change network configuration

The HP Embedded Web Server works when the printer is connected to an IP-based network. The HP Embedded 
Web Server does not support IPX-based printer connections. You do not have to have Internet access to open 
and use the HP Embedded Web Server.

When the printer is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: HP Device Toolbox is software used to connect to the HP Embedded Web Server when the printer is 
connected to a computer via USB. It is available only if a full installation was performed when the printer was 
installed on a computer. Depending on how the printer is connected, some features might not be available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

Method one: Open the HP Embedded Web Server (EWS) from the software

1. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder for 
the printer, and then select the printer name.

2. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Method two: Open the HP Embedded Web Server (EWS) from a web browser

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.
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2. Open a web browser, and in the address line, type the IP address or host name exactly as it appears on the 
configuration report. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.

Tab or section Description

Home tab

Provides printer, status, and 
configuration information.

● Device Status: Shows the printer status and shows the approximate percent life remaining 
of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies. Actual supply 
life remaining can vary. Consider having a replacement supply available to install when print 
quality is no longer acceptable. The supply does not need to be replaced unless the print 
quality is no longer acceptable.

● Device Configuration: Shows the information found on the printer configuration page and 
other device configuration settings.

● Network Summary: Shows the information found on the printer network configuration page 
and other network configuration settings.

● Event Log: Shows a list of all printer events and errors.

● Open Source Licenses: Shows a summary of the licenses for open source software 
programs that can be used with the printer.

System tab

Provides the ability to configure the 
printer from your computer.

● Device Information: Provides basic printer and company information.

● Paper Setup: Change the default paper-handling settings for the printer.

● Energy Settings: Change the default times for entering Sleep/Auto Off mode or automatic 
shut down.

● System Setup: Change the system defaults for the printer.

● Supply Settings: Change the settings for Cartridge is low alert and other supplies 
information.

● Service: Perform the cleaning procedure on the printer.

● Administration: Set or change the printer password. Enable or disable printer features.

NOTE: The System tab can be password-protected. If this printer is on a network, always 
consult with the administrator before changing settings on this tab.

Networking tab

(Network-connected printers only)

Provides the ability to change network 
settings from your computer.

Network administrators can use this tab to control network-related settings for the printer when 
it is connected to an IP-based network. It also allows the network administrator to set up Wireless 
Direct functionality. This tab does not appear if the printer is directly connected to a computer.

NOTE: The Network tab can be password-protected. If this printer is on a network, always 
consult with the administrator before changing settings on this tab.
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Advanced configuration with HP Utility for OS X
Use the HP Utility to check printer status or to view or change printer settings from a computer.

You can use the HP Utility when the printer is connected with a USB cable or is connected to a TCP/IP-based 
network.

Open HP Utility
1. At the computer, open the Applications folder.

2. Select HP, and then select HP Utility.

HP Utility features
The HP Utility toolbar includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility.

● All Settings: Click this button to return to the HP Utility main view.

● HP Support: Click this button to open a browser and go to the HP support website.

● Supplies: Click this button to open the HP SureSupply website.

● Registration: Click this button to open the HP registration website.

● Recycling: Click this button to open the HP Planet Partners Recycling Program website.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the 
tasks that you can perform with HP Utility.

Item Description

Supplies Status Show the printer supplies status and gain access to links for ordering supplies online.

Device Information Show information about the currently selected printer, including the printer Service ID (if 
assigned), the firmware version (FW Version), the Serial Number, and the IP address.

Commands Send special characters or print commands to the printer after the print job.

NOTE: This option is available only after you open the View menu and select the Show 
Advanced Options item.

File Upload Transfer files from the computer to the printer. You can upload the following types of files:

○ HP LaserJet printer command language (.PRN)

○ Portable document format (.PDF)

○ Postscript (.PS)

○ Text (.TXT)

Power Management Configure the printer economy settings.

Update Firmware Transfer a firmware update file to the printer.

NOTE: This option is available only after you open the View menu and select the Show 
Advanced Options item.

HP Connected Access the HP Connected website.
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Item Description

Message Center Display error events that have occurred with the printer.

Network Settings

(Network-connected printers only)

Configure the network settings, such as the IPv4 settings, IPv6 settings, Bonjour settings, 
and other settings.

Supplies Management Configure how the printer should behave when supplies are nearing the end of their 
estimated life.

Trays Configuration Change paper size and type for each of the trays.

Additional Settings Open the HP Embedded Web Server (EWS) for the printer.

NOTE: USB connections are not supported.

Proxy Server Settings Configure a proxy server for the printer.
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Configure IP network settings
● Introduction

● Printer sharing disclaimer

● View or change network settings

● Rename the printer on a network

● Manually configure IPv4 TCP/IP parameters

Introduction
Use the following sections to configure the printer network settings.

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and 
not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the Networking tab to obtain network information. Change settings as needed.

Rename the printer on a network
To rename the printer on a network so that it can be uniquely identified, use the HP Embedded Web Server.

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.
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b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Open the System tab.

3. On the Device Information page, the default printer name is in the Device Description field. You can change 
this name to uniquely identify this printer.

NOTE: Completing the other fields on this page is optional.

4. Click the Apply button to save the changes.

Manually configure IPv4 TCP/IP parameters
Use the EWS to manually set an IPv4 address, subnet mask, and default gateway.

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. On the Networking tab, click the IPv4 Config Method in the left navigation pane.

3. From the IP Preferred Address Method drop-down, select Manual, and then edit the IPv4 configuration 
settings.

4. Click the Apply button.
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Printer security features

Introduction
The printer includes several security features to restrict who has access to configuration settings, to secure data, 
and to prevent access to valuable hardware components.

● Assign or change the system password using the HP Embedded Web Server

Assign or change the system password using the HP Embedded Web Server
Assign an administrator password for access to the printer and the HP Embedded Web Server so that 
unauthorized users cannot change the printer settings.

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. On the System tab, click the Administration link in the left navigation pane.

3. In the area labeled Product Security, enter the password in the Password field.

4. Re-enter the password in the Confirm Password field.

5. Click the Apply button.
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NOTE: Make note of the password and store it in a safe place.
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Energy-conservation settings
● Introduction

● Set the Sleep/Auto Off After Inactivity setting

● Set the Shut Down After Inactivity delay and configure the printer to use 1 watt or less of power

● Set the Delay Shut Down setting

Introduction
The printer includes several economy features to conserve energy and supplies.

Set the Sleep/Auto Off After Inactivity setting
Use the EWS to set the amount of idle time before the printer enters sleep mode.

Complete the following procedure to change the Sleep/Auto Off After setting:

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then select Energy Settings.
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3. From the Sleep/Auto Off After Inactivity drop-down, select the time for the delay.

4. Click the Apply button.

Set the Shut Down After Inactivity delay and configure the printer to use 1 watt or less of 
power

Use the EWS to set the amount of time before the printer shuts down.

NOTE: After the printer shuts down, the power consumption is 1 watt or less.

Complete the following procedure to change the Shut Down After Delay setting:

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then select Energy Settings.

3. From the Shut Down After Inactivity drop-down, select the time for the delay.

NOTE: The default value is 4 hours.

4. Click the Apply button.
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Set the Delay Shut Down setting
Use the EWS to select whether or not the printer delays shutting down after the power button is pressed.

Complete the following procedure to change the Delay Shut Down setting:

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then select Energy Settings.

3. Select or clear the Delay when ports are active option.

NOTE: When this option is selected the printer will not shut down unless all ports are inactive. An active 
network link or fax connection will prevent the printer from shutting down.
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Update the firmware
HP offers periodic printer updates. Follow these steps to update the printer firmware for a single printer.

Update the firmware using the Firmware Update Utility
Use these steps to manually download and install the Firmware Update Utility from HP.com.

NOTE: This method is the only firmware update option available for printers connected to the computer via a 
USB cable. It also works for printers connected to a network.

NOTE: You must have a print driver installed in order to use this method.

1. Go to www.hp.com/go/support, select your country/region or language, and then click the Software and 
Drivers link.

2. Type the printer name in the search field, press the ENTER button, and then select the printer from the list 
of search results.

3. Select the operating system.

4. Under the Firmware section, locate the Firmware Update Utility.

5. Click Download, click Run, and then click Run again.

6. When the utility launches, select the printer from the drop-down list, and then click Send Firmware.

NOTE: To print a configuration page to verify the installed firmware version before or after the update 
process, click Print Config.

7. Follow the on-screen instructions to complete the installation, and then click the Exit button to close the 
utility.
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6 Solve problems

● Customer support

● Laser Warning

● Interpret control-panel light patterns

● Restore the factory-set defaults

● A “Cartridge is low” or “Cartridge is very low” message displays

● Printer does not pick up paper or misfeeds

● Clear paper jams

● Improve print quality

● Resolving print quality problems

● Solve wireless network problems

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljM14.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Customer support
Get telephone support for your country/region

Have the printer name, serial number, date of purchase, and 
problem description ready

Country/region phone numbers are on the flyer that was in the box 
with the printer or at support.hp.com.

Get 24-hour Internet support, and download software utilities and 
drivers

www.hp.com/support/ljM14

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register the printer www.register.hp.com
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Laser Warning

 

CAUTION - CLASS 3B INVISIBLE LASER RADIATION WHEN OPEN. AVOID EXPOSURE TO THE                  
BEAM. 

ATTENTION - RAYONNEMENT LASER INVISIBLE DE ÇLASSE 3B EN CAS D'OUVERTURE. ÉVITEZ 
L'EXPOSITION AU FAISCEAU. 

VORSICHT - UNSICHTBARE LASERSTRAHLUNG KLASSE 3B, WENN ABDECKUNG 
GEÖFFNET. NICHT DEM STRAHL AUSSETZEN. 

PRECAUCIÓN – RADIACIÓN LÁSER INVISIBLE DE CLASE 3B PRESENTE AL ABRIR. EVITE LA 
EXPOSICIÓN AL HAZ. 

VARNING - OSYNLIG LASERSTRÅLNING KLASS 3B VID ÖPPEN LUCKA UNDVIK EXPONERING 
FÖR LASERSTRÅLNINGEN. 

VAROITUS - LUOKAN 3B NÄKYMÄTTÖMÄLLE LASER-SÄTEILYÄ AVATTUNA. VÄLTÄ 
ALTISTUMISTA SÄTEELLE. 

- 3B
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Interpret control-panel light patterns
Table 6-1  Status-light legend

Symbol for "light off"

Symbol for "light on"

Symbol for "light blinking"

Table 6-2  Control-panel light patterns

Light status State of the printer Action

The Attention light is blinking. The printer is in manual-feed mode. Load the correct paper type and size into the input 

tray. Press the Resume/Cancel  button to 

continue.

The printer is processing a manual duplex 
job.

Load the pages into the input tray to print the second 

sides. Press the Resume/Cancel  button to 

continue.

The input tray is empty. Load the tray and press the Resume/Cancel 

button to continue.

NOTE: Wireless models have a paper sensor and 
will continue automatically after paper is loaded.

A door is open. Verify that the toner-cartridge door is fully closed.

The printer has failed to pick up a sheet of 
paper to process a print job.

Verify that paper is correctly loaded, and then press 

the Resume/Cancel  button to continue.

Paper is jammed in the printer. Check for jams in the input tray, the output bin, and 
the toner cartridge area. Clear the jam. Press the 

Resume/Cancel  button to continue.

The toner cartridge is missing or 
incorrectly installed.

Verify that all supplies are in place and installed 
correctly.

The toner cartridge is very low. Replace the toner cartridge.

NOTE: There will be no attention state if the printer 
is configured to continue printing when the toner 
cartridge is very low.

The toner cartridge is incompatible with 
the printer, possibly due to a missing or 
damaged memory chip.

Replace the toner cartridge.

The toner cartridge has been protected on 
another printer.

Replace the toner cartridge.

The printer has detected an unauthorized 
toner cartridge.

Replace the toner cartridge.
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Table 6-2  Control-panel light patterns (continued)

Light status State of the printer Action

The loaded paper is not the size needed 
for the print job.

Replace the paper, or press the Resume/Cancel 

button to continue with the size currently loaded.

The printer has experienced a general 
engine error.

Press the Resume/Cancel  button to continue.

If the error repeats, turn off the printer. Wait 30 
seconds, and then turn on the printer.

Incorrect firmware has been loaded. Press the Resume/Cancel  button to continue, 

Load the correct firmware.

The Attention and Ready lights are 
on.

The printer has experienced a fatal error 
from which it cannot recover.

1. Turn off the printer or disconnect the power 
cord from the printer.

2. Wait 30 seconds, and then turn on the printer or 
reconnect the power cord to the printer.

3. Wait for the printer to initialize.

If the error persists, contact HP customer support.

The Attention and Ready lights are 
blinking.

The printer is initializing, cleaning, or 
cooling down.
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Restore the factory-set defaults
Restoring the factory-set defaults returns all of the printer and network settings to the factory defaults. It will 
not reset the page count. To restore the printer to the factory-default settings, follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also 
deletes any pages that are stored in the memory.

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Go to the Service tab.

3. In the Restore Defaults area, click the Restore defaults button.

The printer automatically restarts.
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A “Cartridge is low” or “Cartridge is very low” message displays
Cartridge is low: The printer indicates when a cartridge level is low. Actual cartridge life remaining may vary. 
Consider having a replacement available to install when print quality is no longer acceptable. The cartridge does 
not need to be replaced now.

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. 
To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth 
about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner 
cartridge into the printer and close the cover.

Cartridge is very low: The printer indicates when the cartridge level is very low. Actual cartridge life remaining 
may vary. Consider having a replacement available to install when print quality is no longer acceptable. The 
cartridge does not need to be replaced now unless the print quality is no longer acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge has 
ended.

Change the “Very Low” settings
You can change the way the printer reacts when supplies reach the Very Low state. You do not have to re-
establish these settings when you install a new toner cartridge.

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.
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b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Select the System tab, and then select Supply Settings.

3. Select one of the following options from the Very Low Setting (Black Cartridge): drop-down:

● Select the Stop option to set the printer to stop printing until you replace the cartridge.

● Select the Continue option to set the printer to alert you that the cartridge is very low, but to continue 
printing.

Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported on your computer, enter the printer IP 
address or host name in the address/URL field. The EWS contains a 
link to the HP SureSupply website, which provides options for 
purchasing Original HP supplies.
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Printer does not pick up paper or misfeeds

Introduction
The following solutions can help solve problems if the printer is not picking up paper from the tray or is picking 
up multiple sheets of paper at one time. Either of these situations can result in paper jams.

● The product does not pick up paper

● The product picks up multiple sheets of paper

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

5. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with 
warm water.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.
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Clear paper jams

Introduction
The following information includes instructions for clearing paper jams from the printer.

● Jam locations

● Experiencing frequent or recurring paper jams?

● Clear jams from the input tray

● Clear jams from inside the product

● Clear jams from the output areas

Jam locations
Jams can occur at the following locations in the product.

1 3

2
1 Internal areas

2 Input tray

3 Output bin

NOTE: Jams can occur in more than one location.
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Experiencing frequent or recurring paper jams?
Follow these steps to solve problems with frequent paper jams. If the first step does not resolve the problem 
continue with the next step until you have resolved the problem.

1. If paper has jammed in the printer, clear the jam and then print a configuration page to test the printer.

2. Check that the tray is configured for the correct paper size and type. Adjust paper settings if necessary.

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

c. Click the System tab, and then click the Paper Setup page.

d. Select the type of paper that is in the tray.

e. Select the size of paper that is in the tray.

3. Turn the printer off, wait 30 seconds, and then turn it on again.

4. Print a cleaning page to remove excess toner from inside the printer.

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

c. On the System tab, click Service.

d. In the Fuser Cleaning mode area, click Start to begin the cleaning process.

5. Print a configuration page to test the printer.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.
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If none of these steps resolves the problem, the printer might need service. Contact HP customer support.
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Clear jams from the input tray

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams. Damage caused 
by sharp objects will not be covered by the warranty.

When removing jammed media, pull the jammed media straight away from the product. Pulling jammed media 
out of the product at an angle can damage the product.

 

NOTE: Depending on where the jam is located, some of the following steps might not be necessary.

1. Open the print-cartridge door, and then remove the print cartridge.

2. Remove the media stack from the input tray.
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3. With both hands, grasp the side of the jammed media that is most visible (this includes the middle), and 
carefully pull it free from the product.

4. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from inside the product
1. Open the print-cartridge door, and then remove the print cartridge.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece of paper.

2. If you can see the jammed paper, carefully grasp the jammed paper, and slowly pull it out of the product.
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3. Reinstall the print cartridge, and then close the print-cartridge door.
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Clear jams from the output areas

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams. Damage caused 
by sharp objects will not be covered by the warranty.

1. Open the print-cartridge door, and then remove the print cartridge.

2. Keep the print cartridge door open, and then with both hands, grasp the side of the jammed media that is 
most visible (this includes the middle), and carefully pull it free from the product.
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3. Reinstall the print cartridge, and then close the print-cartridge door.
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Improve print quality
● Introduction

● Update the printer firmware

● Print from a different software program

● Check the paper-type setting for the print job

● Check toner-cartridge status

● Cartridge cleaning

● Print a cleaning page

● Visually inspect the toner cartridge

● Check paper and the printing environment

● Adjust Print Density

Introduction
The following information provides troubleshooting steps to resolve print-quality problems, including the 
following problems:

● Smears

● Fuzzy print

● Dark print

● Light print

● Streaks

● Missing toner

● Scattered dots of toner

● Loose toner

● Skewed images

To resolve these or other print-quality problems, try the following solutions in the order presented.

For information about resolving specific image defects, see the Resolving print quality problems section of this 
User Guide.

Update the printer firmware
Try upgrading the printer firmware. For more information, see the Update the firmware section of this User 
Guide.

Print from a different software program
Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which you were printing.
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Check the paper-type setting for the print job
Check the paper type setting when printing from a software program and the printed pages have smears, fuzzy 
or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting on the printer

1. Open the tray.

2. Verify that the tray is loaded with the correct type of paper.

3. Close the tray.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the printer, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.

Check the paper type setting (OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the printer.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Finishing menu.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Check toner-cartridge status
Follow these steps to check the estimated life remaining in the toner cartridges and if applicable, the status of 
other replaceable maintenance parts.

Step one: Find supplies information on configuration page

Supplies information is included on the configuration page.

1. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

2. Release the Resume/Cancel  button.
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Step two: Check supplies status

1. Look at the supplies status report to check the percent of life remaining for the toner cartridges and if 
applicable, the status of other replaceable maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The 
configuration report indicates when a supply level is very low.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner 
cartridge has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable. 
Consider having a replacement available to install when print quality is no longer acceptable.

If you determine that you need to replace a toner cartridge or other replaceable maintenance parts, the 
configuration report lists the genuine HP part numbers.

2. Check to see if you are using a genuine HP cartridge.

A genuine HP toner cartridge has “HP” on it, or has the HP logo on it. For more information on identifying 
HP cartridges go to www.hp.com/go/learnaboutsupplies.

Cartridge cleaning
During the printing process, cartridges might be contaminated by paper dust and cause print quality issues such 
as background issues, vertical dark bands, or repetitive horizontal banding.

Follow these steps to improve the above mentioned print quality issues:

1. Open a web browser, and in the address line type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then click Service.

3. In the Cartridge Cleaning Mode area, click Start to begin the cleaning process.

Or use the following procedure to start the Cartridge Cleaning mode:

1. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in the lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder for 
the printer, and then select the printer name.

2. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

3. On the System tab, click Service.

4. In the Cartridge Cleaning Mode area, click Start to begin the cleaning process.
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Print a cleaning page
During the printing process paper, toner, and dust particles can accumulate inside the printer and can cause print-
quality issues such as toner specks or spatter, smears, streaks, lines, or repeating marks.

Use the following procedure to print a cleaning page.

1. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder for 
the printer, and then select the printer name.

2. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

3. On the System tab, click Service.

4. In the Fuser Cleaning mode area, click Start to begin the cleaning process.

Visually inspect the toner cartridge
Follow these steps to inspect the toner cartridge.

1. Remove the toner cartridges from the printer, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum.

CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. Reinstall the toner cartridge, and print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this printer supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, 
staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.
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● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet 
printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding 
issues. Try the following solutions:

● Move the printer away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the printer is not exposed to temperatures or humidity outside of printer specifications.

● Do not place the printer in a confined space, such as a cabinet.

● Place the printer on a sturdy, level surface.

● Remove anything that is blocking the vents on the printer. The printer requires good air flow on all sides, 
including the top.

● Protect the printer from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the printer.

Adjust Print Density
Complete the following steps to adjust the print density.

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the HP Printer Assistant.

● Windows 10: From the Start menu, click All Apps, click HP, and then select the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder 
for the printer, and then select the printer name.

b. In the HP Printer Assistant, select Print, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.
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b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then select System Setup from the left navigation pane.

3. Select the correct density settings.

4. Click Apply to save the changes.
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Resolving print quality problems
● Introduction

● Troubleshoot print quality problems

Introduction
The following information provides troubleshooting steps for solving image defect issues, including the following 
defects:

● Light print

● Gray background or dark print

● Blank pages

● Black pages

● Dark or light bands

● Dark or light streaks

● Missing toner

● Skewed images

● Colors that do not align

● Curled paper

Troubleshoot print quality problems
Table 6-3  Image defects table quick reference

Table 6-4 Light print on page 71 Table 6-5 Gray background or dark print 
on page 72

Table 6-6 Blank page — No print on page 72
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Table 6-3  Image defects table quick reference (continued)

Table 6-7 Black page on page 73 Table 6-8 Banding defects on page 73 Table 6-9 Streak defects on page 74

Table 6-10 Fixing/fuser defects on page 75 Table 6-11 Image placement defects 
on page 75

Table 6-12 Color plane registrations defects 
(color models only) on page 76

Table 6-13 Output defects on page 76   

Image defects, no matter the cause, can often be resolved using the same steps. Use the following steps as a 
starting point for solving image defect issues.
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1. Reprint the document. Print quality defects can be intermittent in nature or can go away completely with 
continued printing.

2. Check the condition of the cartridge. If a cartridge is in a Very Low state (it has passed the rated life), 
replace the cartridge.

3. Make sure that the driver and tray print mode settings match the media that is loaded in the tray. Try using 
a different ream of media or a different tray. Try using a different print mode.

4. Make sure that the printer is within the supported operating temperature/humidity range.

5. Make sure that the paper type, size, and weight are supported by the printer. See the printer support page 
at support.hp.com for a list of the supported paper sizes and types for the printer.

NOTE: The term “fusing” refers to the part of the printing process where toner is affixed to paper.

The following examples depict letter-size paper that has passed through the printer short-edge first.

Table 6-4  Light print

Description Sample Possible solutions

Light print:

The printed content on the entire page is 
light or faded.

1. Reprint the document.

2. Remove the cartridge, and then shake 
it to redistribute the toner.

3. Make sure that the cartridge is 
installed correctly.

4. Print a configuration report and check 
for life and usage of the cartridge.

5. Replace the cartridge.

6. If the problem persists, go to 
support.hp.com.
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Table 6-5  Gray background or dark print

Description Sample Possible solutions

Gray background or dark print:

The image or text is darker than expected.

1. Make sure that the paper in the trays 
has not already been run through the 
printer.

2. Use a different paper type.

3. Reprint the document.

4. Mono models only: From the printer 
EWS, go to the Adjust Toner Density 
menu, and then adjust the toner 
density to a lower level.

5. Make sure that the printer is in within 
the supported operating temperature 
and humidity range.

6. Replace the cartridge.

7. If the problem persists, go to 
support.hp.com.

Table 6-6  Blank page — No print

Description Sample Possible solutions

Blank page — No print:

The page is completely blank and contains 
no printed content.

1. Make sure that the cartridge is 
genuine HP cartridges.

2. Make sure that the cartridge is 
installed correctly.

3. Print with a different cartridge.

4. Check the paper type in the paper tray 
and adjust the printer settings to 
match. If necessary, select a lighter 
paper type.

5. If the problem persists, go to 
support.hp.com.
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Table 6-7  Black page

Description Sample Possible solutions

Black page:

The entire printed page is black.

1. Visually inspect the cartridge to check 
for damage.

2. Make sure that the cartridge is 
installed correctly.

3. Replace the cartridge

4. If the problem persists, go to 
support.hp.com.

Table 6-8  Banding defects

Description Sample Possible solutions

Repetitive wide-pitch banding and Impulse 
bands:

Dark or light lines which repeat down the 
length of the page. They might be sharp or 
soft in nature. The defect displays only in 
areas of fill, not in text or sections with no 
printed content.

1. Reprint the document.

2. Replace the cartridge.

3. Use a different paper type.

4. If the problem persists, go to 
support.hp.com.
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Table 6-9  Streak defects

Description Sample Possible solutions

Light vertical streaks:

Light streaks that usually span the length of 
the page. The defect displays only in areas 
of fill, not in text or sections with no printed 
content.

1. Reprint the document.

2. Remove the cartridge, and then shake 
it to redistribute the toner.

3. If the problem persists, go to 
support.hp.com.

NOTE: Both light and dark vertical streaks 
can occur when the printing environment is 
outside the specified range for temperature 
or humidity. Refer to your printer's 
environmental specifications for allowable 
temperature and humidity levels.

Dark vertical streaks and ITB cleaning 
streaks (color models only):

Dark lines which occur down the length of 
the page. The defect might occur anywhere 
on the page, in areas of fill or in sections 
with no printed content.

1. Reprint the document.

2. Remove the cartridge, and then shake 
it to redistribute the toner.

3. Print a cleaning page.

4. Check the toner level in the cartridge.

5. If the problem persists, go to 
support.hp.com.
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Table 6-10  Fixing/fuser defects

Description Fixing/fuser Possible solutions

Hot fuser offset (shadow):

Slight shadows, or offsets, of the image 
repeated down the page. The repeated 
image might fade with each recurrence.

1. Reprint the document.

2. Check the paper type in the paper tray 
and adjust the printer settings to 
match. If necessary, select a lighter 
paper type.

3. If the problem persists, go to 
support.hp.com.

Poor fusing:

Toner rubs off along either edge of page. 
This defect is more common at the edges of 
high-coverage jobs and on light media types 
but can occur anywhere on the page.

1. Reprint the document.

2. Check the paper type in the paper tray 
and adjust the printer settings to 
match. If necessary, select a heavier 
paper type.

3. If the problem persists, go to 
support.hp.com.

Table 6-11  Image placement defects

Description Sample Possible solutions

Margins and skew:

The image is not centered, or is skewed on 
the page. The defect occurs when the paper 
is not positioned properly as it is pulled from 
the tray and moves through the paper path.

1. Reprint the document.

2. Remove the paper and then reload the 
tray. Make sure that all the paper 
edges are even on all sides.

3. Make sure that the top of the paper 
stack is below the tray full indicator. 
Do not overfill the tray.

4. Make sure that the paper guides are 
adjusted to the correct size for the 
paper. Do not adjust the paper guides 
tightly against the paper stack. Adjust 
them to the indentations or markings 
in the tray.

5. If the problem persists, go to 
support.hp.com.
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Table 6-12  Color plane registrations defects (color models only)

Description Sample Possible solutions

Color plane registrations:

One or more color of the planes is not 
aligned with the other color planes. The 
primary error will typically occur with yellow.

1. Reprint the document.

2. From the printer control panel, 
calibrate the printer.

3. If a cartridge has reached a Very Low 
state or the printed output is severely 
faded, replace the cartridge.

4. From the printer control panel use the 
Restore Calibration feature to reset 
the printer's calibration settings to the 
factory defaults.

5. If the problem persists, go to 
support.hp.com.

Table 6-13  Output defects

Description Sample Possible solutions

Output curl:

Printed paper has curled edges. The curled 
edge can be along the short or long side of 
the paper. Two types of curl are possible:

● Positive curl: The paper curls toward 
the printed side. The defect occurs in 
dry environments or when printing 
high coverage pages.

● Negative curl: The paper curls away 
from the printed side. The defect 
occurs in high-humidity environments 
or when printing low coverage pages.

1. Reprint the document.

2. Positive curl: From the printer EWS, 
select a heavier paper type. The 
heavier paper type creates a higher 
temperature for printing.

Negative curl: From the printer EWS, 
select a lighter paper type. The lighter 
paper type creates a lower 
temperature for printing. Try storing 
the paper in a dry environment prior or 
use freshly opened paper.

3. Print in duplex mode.

4. If the problem persists, go to 
support.hp.com.

Output stacking:

The paper does not stack well in the output 
tray. The stack might be uneven, skewed, or 
the pages might be pushed out of the tray 
and onto the floor. Any of the following 
conditions can cause this defect:

● Extreme paper curl

● The paper in the tray is wrinkled or 
deformed

● The paper is a non-standard paper 
type, such as envelopes

● The output tray is too full

1. Reprint the document.

2. Extend the output bin extension.

3. If the defect is caused by extreme 
paper curl, complete the 
troubleshooting steps for Output curl.

4. Use a different paper type.

5. Use freshly opened paper.

6. Remove the paper from the output 
tray before the tray gets too full.

7. If the problem persists, go to 
support.hp.com.
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Solve wireless network problems
● Introduction

● Wireless connectivity checklist

● The printer does not print after the wireless configuration completes

● The printer does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or printer

● Cannot connect more computers to the wireless printer

● The wireless printer loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

● Perform a wireless network diagnostic test

● Reduce interference on a wireless network

Introduction
Use the troubleshooting information to help resolve issues.

NOTE: To determine if Wi-Fi Direct printing is enabled on your printer, print a configuration page from the 
printer control panel

Wireless connectivity checklist
● Verify that the printer and the wireless router are turned on and have power. Also make sure that the 

wireless radio in the printer is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the SSID.

a. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

b. Release the Resume/Cancel  button.

If you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is 
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network. If the 
network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the printer as it is for the wireless access 
point (on networks using WPA security).

● Verify that the printer is within the range of the wireless network. For most networks, the printer must be 
within 30 m (100 ft) of the wireless access point (wireless router).
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● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the access 
point and the printer. Make sure poles, walls, or support columns containing metal or concrete do not 
separate the printer and wireless access point.

● Verify that the printer is located away from electronic devices that might interfere with the wireless signal. 
Many devices can interfere with the wireless signal including motors, cordless phones, security system 
cameras, other wireless networks, and some Bluetooth devices.

● Verify that the print driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and printer connect to the same wireless network.

● For OS X, verify that the wireless router supports Bonjour.

The printer does not print after the wireless configuration completes
1. Make sure that the printer is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.

5. Verify that you can open the printer HP Embedded Web Server from a computer on the network.

The printer does not print, and the computer has a third-party firewall installed
1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the printer or try to print, make sure you allow the 
programs to run.

3. Temporarily turn off the firewall, and then install the wireless printer on the computer. Enable the firewall 
when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or printer
1. Make sure that the router or printer connects to the same network that your computer connects to.

2. Print a configuration page.

3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer configuration 
for the computer.

4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the 
wireless setup for the printer.

Cannot connect more computers to the wireless printer
1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. 

For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the printer is turned on and in the ready state.

3. Make sure there are not more than 5 concurrent Wi-Fi Direct users.
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4. Turn off any third-party firewalls on your computer.

5. Make sure that the wireless network is working correctly.

6. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless printer loses communication when connected to a VPN
● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list
● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning
1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.

a. Open a command-line prompt on your computer.

● For Windows, click Start, click Run, type cmd, and then press Enter.

● For OS X, go to Applications, then Utilities, and open Terminal.

b. Type ping followed by the router IP address.

c. If the window displays round-trip times, the network is working.

3. Make sure that the router or printer connects to the same network that the computer connects to.

a. Print a configuration page.

i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer 
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure 
the wireless setup for the printer.

Perform a wireless network diagnostic test
A wireless network diagnostic test can be performed using the printer control panel or the Embedded Web 
Server (EWS). The wireless network diagnostic test provides information about the wireless network settings.

Method one: Perform wireless network diagnostic test using the EWS

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.
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i. Press and hold the Resume/Cancel  button until the Ready  light begins blinking.

ii. Release the Resume/Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the displays a message indicating that accessing the website might not be safe, select the 
option to continue to the website. Accessing this website will not harm the computer.

2. Select the Networking tab.

3. On the Wireless Configuration page, verify that the On option is selected.

4. Click the Print Test Report button to print a test page that shows test results.

Method two: Perform a wireless network diagnostic test using the printer control panel

▲ From the printer control panel, press and hold the wireless button for 20 seconds.

Reduce interference on a wireless network
The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other electromagnetic 
devices, such as microwaves and cordless telephones. These objects can disrupt radio signals.

● Keep the wireless devices away from large masonry structures and other building structures. These objects 
can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless printers on the network.
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